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Assalamualaikum Wr. Wb. 

Puji syukur kami panjatkan ke hadirat Allah SWT, atas limpahan rahmat dan 

hidayah-nya penulis dapat menyelesaikan Modul Praktikum Statika. Modul ini 

disusun sebagai panduan untuk mahasiswa Program Studi Teknik Sipil Universitas 

Muhammadiyah Yogyakarta dalam Praktikum Mata Kuliah Statika. 

Pada modul ini, materi terbagi menjadi 2 bagian, yaitu materi perhitungan soal 

dengan metode perhitungan manual dan perhitungan dengan alat bantu program 

SAP2000. Modul ini memuat contoh-contoh soal yang dapat dijadikan panduan di 

dalam memecahkan soal lainnya dan langkah-langkah pemecahan soal tersebut 

dengan alat bantu program SAP2000. 

Penulis mengucapkan terima kasih kepada semua pihak yang telah membantu 

dalam proses penyusunan modul ini sehingga dapat diselesaikan dengan baik dan 

tepat waktu. Akan tetapi, modul ini masih jauh dari sempurna dan tidak memuat 

semua materi yang mencakup semua materi Statika. Oleh karena itu, kritik dan 

saran yang bersifat membangun sangat penulis harapkan demi kualitas modul yang 

lebih baik. 

Semoga modul ini bermanfaat untuk para mahasiswa yang sedang bersemangat 

menuntut ilmu. 

Wassalamualaikum Wr. Wb. 

 
 

Yogyakarta, 10 Februari 2022 
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BAB I. PRINSIP DASAR STATIKA 

 
 

1.1. Pengertian Umum 

Menurut Frick (1978) ilmu statika adalah ilmu tentang semua benda yang 

tetap, yang statis, semua yang tidak bergerak (atau yang tidak akan bergerak). Lain 

halnya dengan ilmu dinamika yaitu ilmu tentang semua yang bergerak. Kedua ilmu 

tersebut mempunyai dua persamaan, yaitu gaya-gaya dan pergerakan. Hanya bahwa 

dalam ilmu statika kita hanya bekerja dengan gaya-gaya yang tidak bergerak, 

dengan keadaan pergerakan sama dengan nol (v = 0). Hal ini dapat terjadi apabila 

semua gaya yang membebani suatu benda dan gaya-gaya pada tangkai pengungkit 

(dengan jarak antara gaya dan benda = momen) saling menutupi, sehingga semua 

gaya seimbang. Oleh sebab itu ilmu statika juga disebut ilmu keseimbangan gaya 

atau dengan singkat ilmu keseimbangan. 

Statika merupakan ilmu yang mempelajari kesetimbangan gaya, dimana 

gaya-gaya tersebut dalam keadaan diam (kesetimbangan suatu struktur). Ilmu 

statika bermanfaat untuk mengetahui gaya-gaya yang bekerja dalam suatu struktur 

yang berguna dalam perancangan struktur tersebut. 

1.1.1. Persamaan Kesetimbangan 

Agar dapat menerapkan prinsip-prinsip statika pada suatu sistem, maka 

struktur tersebut harus dalam keadaan setimbang. Hal ini dapat dipenuhi jika jumlah 

semua gaya meliputi beban-beban kerja dan reaksi perletakan (reaksi tumpuan) 

adalah sama dengan nol. Selain itu harus terpenuhi pula bahwa jumlah momen-

momen gaya terhadap suatu titik adalah sama dengan nol (Setiawan, 2015). Sistem 

gaya-gaya yang bekerja pada struktur akan seimbang apabila memenuhi syarat 

keseimbangan statik, yaitu: 

a. (ΣH=0)       Tidak bergerak dalam arah horizontal, (1.1) 

b. (ΣV=0) Tidak bergerak dalam arah vertikal, dan (1.2) 

c. (ΣM=0) Tidak berputar. (1.3) 

Ketiga syarat kesetimbangan tersebut disebut dengan tiga persamaan 

dasar kesetimbangan. 
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1.1.2. Perbedaan Struktur Statis Tertentu dan Tak tentu 

Dalam ilmu analisis struktur dikenal sistem statis tertentu dan statis tak 

tentu. Suatu sistem struktur dikategorikan sebagai sistem statis tertentu apabila 

semua gaya dalam dan reaksi pada tumpuan-tumpuannya dapat dihitung dengan 

persamaan kesetimbangan yang ada (persamaan 1.1, 1.2, dan 1.3). 

Persyaratan suatu struktur dikatakan struktur statis tertentu dapat ditulis: 
 

Keterangan: 

n = jumlah batang 

i=jumlah reaksi tumpuan 

j=jumlah titik kumpul (joint)                

Contoh: 

Contoh 1 
 
 

Gambar 1.1 Contoh 1 

Balok pada gambar diatas memiliki j =2, n =1, dan i =3, maka: 

    3n+i =3(1)+(3)=6  

  3j = 3(2) =6  

Sehingga, struktur diatas merupakan strukur statis tertentu karena 3n+i =3j. 

Contoh 2 

Gambar 1. 2 Contoh 2 

Balok pada gambar diatas memiliki j =2, n =1, dan i =4, maka: 

3n+i =3(1)+(4)=7  

  3j = 3(2) =6  
 

Sehingga, struktur diatas merupakan strukur statis tak tentu karena 3n+r > 3j. 

 persamaan  (1.4) 
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1.2. Jenis-jenis Tumpuan 

Menurut Setiawan (2015) semua beban yang bekerja pada struktur pada 

akhirnya akan dipikul oleh tumpuan. Ada beberapa jenis tumpuan yang akan sering 

dijumpai dalam suatu proses analisis strutur. Masing-masing jenis tumpuan 

mempunyai karakteristik yang berbeda-beda. 

1.2.1. Tumpuan Rol 

Tumpuan rol hanya dapat menahan gaya dalam arah tegak lurus (vertikal) 

saja dan tidak mampu menahan momen. Jadi tumpuan rol hanya mempunyai satu 

gaya reaksi yang tegak lurus dengan Rol. 

 

Gambar 1.3 Tumpuan rol pada jembatan 

1.2.2. Tumpuan Sendi 

Tumpuan sendi ini dapat menerima gaya dari segala arah tetapi tidak 

mampu menahan momen, sehingga tumpuan jenis ini hanya mampu berotasi. 

Dengan demikian, tumpuan sendi mempunyai dua gaya reaksi. 

 

Gambar 1.4 Tumpuan sendi pada jembatan 
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1.2.3. Tumpuan Jepit 

Tumpuan Jepit dapat menahan gaya dalam segala arah (baik vertikal 

maupun horizontal) dan dapat menahan momen. Jenis tumpuan ini tidak mengalami 

rotasi dan translasi, sehingga sering juga disebut tumpuan kaku  (rigid). Dengan 

demikian tumpuan jepit mempunyai tiga gaya reaksi. 

 

Gambar 1.5 Tumpuan jepit pada bangunan 

 
 

1.3. Gaya pada Struktur 

Gaya merupakan suatu sebab yang mengubah suatu benda yang tadinya diam 

menjadi bergerak atau dari bergerak menjadi diam. Gaya termasuk dalam besaran 

vektor, yaitu memiliki nilai dan arah. Dalam statika, gaya dapat diartikan sebagai 

muatan yang bekerja pada struktur. 

Momen gaya juga merupakan salah satu besaran yang penting dalam ilmu 

analisis struktur. Menurut Setiawan (2015) momen gaya terhadap suatu titik disebut 

sebagai hasil kali gaya dengan jarak tegak lurusnya ke titik tersebut, dapat bernilai 

positif atau negatif tergantung dari perjanjian tanda yang digunakan  dalam analisis. 

1.3.1. Gaya Luar 

Gaya luar merupakan gaya-gaya yang bekerja di luar struktur 

(muatan/beban). Gaya-gaya tersebut timbul pada struktur diakibatkan oleh adanya 

beban-beban layan yang bekerja pada struktur tersebut. Macam-macam beban yang 

umum dijumpai pada suatu sistem struktur diatur dalam SNI 1727:2020 tentang         

.  
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beban desain minimum dan kriteria terkait untuk bangunan gedung dan struktur 

lain. Beban-beban tersebut diantaranya adalah beban mati, beban hidup, beban 

angin, dan beban gempa. 

Pembebanan-pembebanan tersebut secara umum dibedakan menjadi dua 

jenis berdasarkan permukaan bidang tekannya, yaitu: 

1.3.1.1.  Beban Titik 

Beban titik atau beban terpusat adalah beban yang bekerja pada suatu titik. 

Satuan yang dipakai biasanya adalah kilogram (kg), ton (T), Newton (N), kilo 

Newton (kN), dsb. Contoh dalam kehidupan nyata seperti berat seseorang melalui 

kaki, atau berat kolom pada pondasi. 

 

 
 

 

Gambar 1.6 Beban titik 

1.3.1.2.  Beban Merata 

Beban Merata adalah beban yang bekerja merata dalam suatu panjang atau 

luas tertentu. Satuan yang biasa dipakai adalah kg/m, kg/cm, N/m. Ada 2 macam 

beban merata yaitu: 

a. Beban merata berbentuk persegi panjang 

Contoh dalam kehidupan nyata seperti berat sekelompok orang pada suatu 

ruangan, berat sloof pada pondasi. 

 

 
Gambar 1.7 Beban merata persegi panjang 
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Rumus resultan gayanya dapat ditulis. 
 

R adalah resultan gaya dan letak R melalui titik berat persegi panjang. 

b. Beban merata berbentuk segitiga 

Contoh dalam kehidupan nyata yaitu tekanan hidrostatik air pada 

dinding. 

 

Gambar 1.8 Beban merata berbentuk segitiga 

 

Rumus resultan gayanya dapat ditulis. 
 

   

 

R adalah resultan gaya dan letak R melalui titik berat segitiga. 

1.3.2. Reaksi Perletakan 

Reaksi perletakan atau reaksi tumpuan adalah reaksi pada suatu tumpuan 

yang timbul akibat adanya gaya luar yang bekerja, sehingga terjadi kesetimbangan. 

Setimbang merupakan kondisi yang tidak bergerak, sehingga struktur dalam 

keadaan stabil. Untuk menghitung reaksi perletakan, digunakan tiga persamaan 

dasar kesetimbangan (persamaan 1.1, 1.2, dan 1.3) dan persamaan tambahan jika 

ada. 

Perjanjian tanda untuk menghitung reaksi perletakan: 

a. Gaya horizontal 

Ke kanan ( ) bernilai positif (+) 

Ke kiri ( ) bernilai negatif (-) 

b. Gaya vertikal 

Ke atas ( ) bernilai positif (+) 

Ke bawah ( ) bernilai negatif (-) 

Persamaan (1.6) 

R =q.L Persamaan (1.5) 
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c. Momen 

Searah jarum jam, bernilai positif (+) 

Berlawanan arah jarum jam, bernilai negatif (-) 

1.3.3. Gaya Dalam 

Gaya dalam merupakan gaya yang timbul di dalam suatu benda atau struktur 

akibat bekerjanya gaya luar. Menurut Megson (2005) suatu struktur dapat 

mengalami gaya yang rumit, tetapi gaya-gaya yang dialami struktur tersebut dapat 

terbagi menjadi empat jenis pembebanan dasar, yaitu gaya normal/gaya aksial, 

beban geser, momen lentur, dan torsi. 

Pada praktikum statika ini kita hanya membahas tentang gaya normal, gaya 

geser, dan momen lentur beserta penggambaran diagram gaya dalamnya. 

Pembahasan tentang torsi akan dibahas di mata kuliah lainnya. Penggambaran 

diagram gaya dalam untuk yang bernilai positif, diagram diarsir tegak lurus, dan 

yang bernilai negatif di arsir sejajar dengan sumbu batang. 

 
1.3.3.1 Gaya Normal / Axial Force 

Menurut Megson (2005) Gaya normal adalah gaya yang sejajar dengan 

sumbu memanjang batang. Apabila gaya tersebut cenderung menimbulkan sifat 

tarik (meningkatkan panjang batang) maka batang tersebut mengalami tarikan dan 

diberi arah panah ke luar sumbu memanjang batang (bertanda positif). 

Gambar 1.9 Gaya normal yang menimbulkan tarik 
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Sedangkan apabila gaya tersebut cenderung menimbulkan sifat desak 

(memendekkan panjang batang) maka batang tersebut mengalami desakan dan 

diberi arah panah ke dalam sumbu memanjang batang (bertanda negatif). 

 

 

Gambar 1.10 Gaya normal yang menimbulkan desak/tekan 

 
 

Besarnya gaya normal sepanjang batang selanjutnya digambarkan dalam 

bentuk diagram gaya normal/normal force diagram (NFD) Satuan gaya normal 

biasanya dinyatakan dalam kilogram (kg), ton (T), Newton (N), kilo Newton (kN), 

dsb. 

1.3.3.2 Gaya Geser / Shear Force 

Menurut Setiawan (2015) gaya geser adalah gaya yang tegak lurus 

(vertikal) dengan sumbu memanjang batang. Gaya vertikal tersebut dapat terdiri 

dari reaksi tumpuan dan beban yang bekerja. Besarnya gaya geser sepanjang batang 

selanjutnya digambarkan dalam bentuk diagram gaya geser/shear force diagram 

(SFD). Tanda positif digunakan jika resultan gaya geser dari tinjauan sebelah kiri 

mempunyai arah ke atas. Satuan gaya geser biasanya dinyatakan dalam kilogram 

(kg), ton (T), Newton (N), kilo Newton (kN), dsb. 

1.3.3.3. Momen Lentur 

Menurut Soemono (1978) untuk memenuhi syarat keseimbangan, momen 

gaya diantara kedua ujung batang harus sama besarnya serta arah kerjanya 

berlawanan. Sumbu memanjang batang yang semula lurus akan membentuk garis   

.
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lengkung yang cembung (konvex) ke bawah atau cekung (konkaf) ke atas. Kejadian 

ini disebut lentur. Sehingga momen lentur adalah momen gaya yang menyebabkan 

struktur menjadi lengkung/bengkok. 

 

 

 
 

Gambar 1.11 Momen lentur yang membengkokkan batang  

Selanjutnya momen lentur di sepanjang bentang dapat menggambarkan 

diagram momen lentur/bending moment diagram (BMD). Momen lentur bernilai 

positif apabila momen tersebut menghasilkan tegangan tarik pada serat bawah 

terluar dari balok. Nilai maksimum momen lentur terjadi pada saat gaya geser 

bernilai nol seperti yang ditunjukan oleh gambar 1.12 (Setiawan, 2015). Satuan 

momen lentur biasanya dinyatakan dalam kilogram meter (kgm), ton meter (tm), 

Newton meter (Nm), kilo Newton meter (kNm), dsb. 
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Gambar 1.12 Gaya geser dan momen lentur pada balok 
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1.4. Segitiga Gaya 

Menurut Setiawan (2015) apabila 3 gaya sebidang bekerja pada suatu struktur 

yang berada dalam keadaan setimbang, ketiga buah gaya tersebut akan membentuk 

segitiga gaya. 

Pada Gambar 1.13 ditunjukkan tiga buah gaya sebidang yang saling bertemu 

pada satu titik tangkap. Jika pangkal dari gaya F2 diletakkan pada ujung dari gaya 

F1, gaya F3 yang berasal dari ujung F2 dan bertemu dengan pangkal dari F1 disebut 

sebagai gaya penyeimbang (lihat Gambar 1.13 yang b). Apabila pangkal gaya F3 

tadi diletakkan pada pangkal F1, sedangkan ujung F3 diletakkan pada ujung F2 

(Gambar 1.13 yang c), maka F3 disebut sebagai resultan dari F1dan F2. 

 
 

Gambar 1.13 Konsep Segitiga Gaya 

 

 

Besarnya gaya resultan F3 dapat dihitung menggunakan persamaan berikut: 

Atau dengan menggunakan aturan trigonometri, diperoleh hubungan: 

1.5. Tipe-tipe Struktur 

  

 
 

Secara garis besar, struktur dibedakan menjadi tiga berdasarkan prinsip 

pemikul gaya yang dilakukan oleh masing-masing tipe yaitu struktur balok, struktur             

. 

persamaan (1.7) 

Persamaan (1.8) 
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rangka, dan struktur portal (Setiawan, 2015). Tipe struktur yang akan ditinjau 

dalam praktikum ini adalah struktur balok dan struktur rangka secara dua dimensi. 

 

1.5.1. Struktur Balok 

Struktur balok merupakan elemen struktur paling sederhana yang banyak 

digunakan sebagai pemikul beban. Balok merupakan suatu batang dengan bentang 

tertentu dan terdapat tumpuan di salah satu ujungnya atau di beberapa titik (joint). 

 

Gambar 1.14 Contoh struktur balok sederhana pada jembatan 
 

 

Gambar 1.15 Contoh struktur balok kantilever pada kanopi 
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1.5.2. Struktur Rangka (Truss) 

Struktur rangka (truss) terdiri dari beberapa batang yang saling terhubung 

sehingga membentuk elemen-elemen segitiga. Masing-masing hanya memikul 

gaya aksial. 

 

Gambar 1.16 Jembatan Kretek Yogyakarta struktur rangka (Truss) 3 dimensi 

Sumber: Dokumentasi Pribadi 



 

 

BAB II. PROGRAM SAP2000 

2.1. Pengenalan Program 

Pada perhitungan struktur yang kompleks dan rumit perlu adanya alat bantu 

hitungan untuk mempermudah pengerjaan dan memperkecil resiko kesalahan. Alat 

bantu yang dimaksud di sini tidak lain lain adalah program komputer dengan 

kemampuan dan fasilitas yang mampu mengerjakan perhitungan seperti pada 

hitungan manual dengan cepat dan tepat. Berapapun jumlah bentangan atau jumlah 

lantai akan ditangani dengan mudah dengan proses perhitungan lewat komputer. 

Salah satu program yang sangat popular di bidang analisis struktur adalah 

SAP2000. 

SAP2000 yang merupakan singkatan dari Structural Analysis Program 2000 

adalah program aplikasi komputer yang digunakan untuk menganalisis dan 

mendesain suatu struktur yang berorientasi obyek (Object Oriented Programing). 

SAP2000 merupakan program yang berasal dari Universitas of California at 

Berkeley, USA sekitar tahun 1970. Dari tahun ketahun SAP mengalami 

perkembangan yang cukup berarti, dari SAP yang under DOS hingga sekarang 

sudah sampai ke SAP yang under window. Untuk melayani keperluan komersial 

dari program SAP, pada tahun 1975 dibentuklah perusahaan komputer yang diberi 

nama CSi (Komputer and Structure,Inc). Perusahaan ini dipimpin oleh Ashraf 

Habibullah, yang sampai sekarang masih tetap eksis dan berkembang. Jika ingin 

mengetahui lebih lanjut perusahaan ini anda dapat mengunjungi situs 

(http://www.csiberkeley.com). 

Suatu catatan penting yang patut di ketahui dan dipahami bahwa secanggih 

apapun program komputer, keputusan tetap ada di tangan manusia yang 

memakainya, apakah model sudah mampu mencerminkan kondisi sebenarnya, 

karena yang perlu diingat adalah program tersebut hanyalah alat bantu saja. Oleh 

karena itu, walaupun telah ada program untuk mambantu dalam perhitungan 

analisis struktur, diharapkan pemakainya telah memahami konsep dari perhitungan 

dan perancangan itu sendiri. 
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2.2. Dasar-dasar Program 

Program SAP2000 yang digunakan dalam praktikum ini adalah SAP2000 

v14.1. Sebelum memulai menggunakan program SAP2000, terlebih dahulu harus 

dipahami dasar-dasar dari program tersebut, sehingga akan dihasilkan output yang 

sesuai dengan harapan. 

2.2.1. Layar Tampilan SAP2000 

Beberapa tool yang ada dalam program beserta penjelasannya sebagai 

berikut: 

 

Gambar 2.1 Tampilan program SAP2000 

a. Menu Perintah 

Baris ini berisi kumpulan perintah-perintah yang tersaji dalam bentuk 

menu dan sub-menu. Menu dikelompokkan menurut fungsinya, misalnya pada 

menu File untuk menangani permasalahn pada File, seperti open, save, dll; menu 

Edit untuk melakukan perubahan data dll. 

b. Menu Perintah (Toolbar) 

Toolbar mempunyai fungsi yang sama dengan menu perintah, tetapi 

digunakan hanya dengan 1 kali klik pada tombol yang sesuai dan perintah 

langsung dijalankan. 
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c. Layar (Window) 

Merupakan  tempat  ditampilkanya  model  struktur,  termasuk  data   input 

maupun data output dalam bentuk grafis. Dapat dikondisikan sesuai kebutuhan. 

d. Elemen Batang (frame) 

Elemen frame merupakan model pada SAP2000 yang berupa batang/garis 1 

dimensi pada arah panjang saja. Tipe penampang dan material dapat diubah 

sesuai kebutuhan, misal penampang persegi (balok), I (profil baja) dan lain- lain. 

e. Element Tumpuan (Restraint) dan joint 

Joint merupakan elemen nodal pada SAP2000, yang lazimnya terdapat pada 

tiap ujung elemen (frame, area, solid) namun dapat pula ditambahkan pada 

tempat-tempat lain. 

Restraint merupakan element joint yang mewakili kondisi tumpuan 

(support) seperti sendi, rol, atau jepit. Tumpuan lain disesuaikan dengan 

keperluan, dapat pula tergantung arah dan jenis kekangan tumpuan, termasuk 

spring (pegas). 

f. Indikator sumbu global (X-Y-Z) 

Indikator ini menjadi alat bantu penunjuk bidang gambar yang aktif. Pada 

tampilan perspektif 3 dimensi, semua sumbu akan terlihat, sedangkan pada 

tampilan 2 dimensi, hanya terlihat 2 sumbu. 

g. Gridline (garis bantu) 

Gridline merupakan garis-garis yang tampak di layar sebagai bantuan dalam 

penggambaran model struktur. Fungsinya mirip seperti kertas millimeter dimana 

garis-garisnya hanya sebagai garis bantu saja. Gridline tidak berpengaruh 

terhadap hasil analisis struktur. 

h. Baris Status 

Pada bagian kiri bawah layar SAP2000 akan terlihat baris ini, yang 

tampilannya berubah-ubah sesuai perintah yang dikerjakan. 

i. Indikator Koordinat Kursor 

Pada baris ini selalu tampil koordinat kursor (panah penunjuk) dalam 3 

dimensi, yang mengacu pada sumbu-sumbu koordinat yang ada. 
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j. Indikator satuan yang digunakan 

Pada bagian kanan bawah latar SAP2000 terlihat indikator satuan yang 

sedang aktif (satuan gaya, satuan panjang dan satuan suhu). Semua input dan 

output akan memakai satuan yang dipilih pada bagian ini. 

2.2.2. Sistem Koordinat 

Dalam program SAP2000, digunakan 2 sistem koordinat yang bias dipakai, 

yaitu: 

a. sistem koordinat cartesian, berupa bidang ruang datar/kotak sumbu x-y-z, 

b. sistem koordinat cylindrical, berupa bidang ruang melingkar/silindris sumbu r- 

θ-z. 

2.2.2.1.Sumbu Global dan Sumbu Lokal 

Pada SAP2000 dikenal istilah 2 macam sumbu: 

a. Sumbu global 
 

Sistem koordinat Global terdiri dari 3 sumbu, X, Y, dan Z yang saling tegak 

lurus sesuai dengan aturan "kaidah tangan kanan", dalam SAP 2000 selalu 

mengasumsikan sumbu Z arahnya vertikal keatas (nilai positif) dan kebawah 

bernilai negatif. Lebih jelasnya lihat gambar dibawah ini. 

 

Gambar 2.2 Sumbu global yang sesuai dengan kaidah tangan kanan 

                             Sumber: fendypermana.blogspot.com 
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b. Sumbu lokal 

Pada orientasi default SAP 2000 koordinat lokal terdapat 3 garis yang saling 

tegak lurus, sumbu lokal 1 berwarna merah. sumbu lokal 2 berwarna putih. 

sumbu lokal 3 berwarna biru. 

 
 

Gambar 2.3 Sumbu lokal 

Sumber: fendypermana.blogspot.com 

Berikut beberapa ketentuan dalam sumbu lokal: 

1) Orientasi sumbu lokal 1 arahnya selalu memanjang arah / element frame, 

dimana arah positif ialah dari ujung "i" ke ujung "j". 

2) Orientasi default sumbul lokal 2 dan 3 ditentukan oleh hubungan sumbu 

lokal 1 dan sumbu global Z sebagai berikut 

a) jika sumbu lokal 1 arahnya horizontal, maka arah sumbu lokal 2 

sejajar dengan sumbu global z, 

b)  jika sumbu lokal 1 arahnya keatas (z+), maka arah sumbu lokal 2 

sejajar dengan sumbu global x(-), dan 

c) sumbu lokal 3 arahnya selalu horizontal tegak lurus bidang X-Y. 

3) Untuk arah putaran momen atau puntir, juga berlaku kaidah tangan kanan 

seperti pada gambar 2.4 di bawah ini. Rotasi positif ialah searah jarum jam 

apabila sumbu 1 menjahi arah pengamat. Gambar dibawah ini untuk 

memperjelas uraian di atas, terlihat arah sumbu X menjauhi pengamat. 
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Gambar 2.4 Kaidah tangan kanan putaran momen atau torsi 

Sumber: fendypermana.blogspot.com 

2.2.3. Objek dan Elemen 

Elemen dasar yang digunakan untuk pemodelan SAP2000 adalah: 

a. Joint (titik nodal), berupa elemen titik/nodal, 

b. Frame (batang), berupa elemen garis (1D), 

c. Area, merupakan elemen luasan (2D), dan 

d. Solid, merupakan elemen ruang (3D). 

 

2.2.4. Pemilihan Elemen dan Assignment 

Dalam memilih elemen (joint, frame, area, solid), SAP2000 menyediakan 

beberapa cara berikut: 

a. Klik atau pilih langsung elemen yang diinginkan. 

b. Cara windowing (melingkupi elemen yang dimaksud). 

c. Lewat menu select, atau beberapa jenis pilihan yang tersedia pada toolbar. 

Untuk cara yang pada point b, elemen yang akan dipilih diliputi dengan cara 

klik kiri tombol mouse, lalu tahan dan geser (drag) sampai terbentuk  kotak garis 

putus-putus yang akan melingkupi elemen yang dimaksud, kemudian dilepas. 

Perlu diperhatikan bahwa arah lingkupan memberikan hasil berbeda, yaitu 
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1) Windowing dari arah kiri ke kanan, akan memilih elemen yang dilingkupi 

kotak saja, 

2) Windowing dari arah kanan ke kiri, akan memilih semua elemen yang 

terkena kotak. 

Sedangkan untuk cara pada point c, lewat menu select > select > …),  dapat 

dipilih elemen-elemen tertentu saja, berdasarkan jenis elemen, tipe penampang, 

dll. Untuk beberapa jenis pilihan tertentu, ada toolbar yang tersedia, yaitu 

1) untuk memilih seluruh elemen: , 

2) untuk memilih elemen terakhir yag telah dipilih sebelumya: , dan 

3) untuk menghilangkan pilihan :  (atau tekan Esc pada keyboard). 

Untuk proses assignment, seperti penggantian tipe penampang, pemasukan 

beban, dll, urutannya adalah 

1) Pemilihan elemen yang dimaksud (dengan metode yang diinginkan, 

2) Assignment pada elemen yang dimaksud. 

Dengan demikian, misal untuk mengganti tipe tumpuan nodal, maka yang 

harus dilakukan adalah memilih joint yang dimaksud terlebih dahulu, kemudia 

mengganti restraint lewat menu Assign > Joint > Restraint dan memilih jenis 

tumpuan yang sesuai. 

2.3. Langkah-langkah Pemodelan Struktur 

Sebelum melakukan pemodelan struktur, terlebih dahulu buka program 

SAP2000. Setelah program terbuka, selanjutnya dilakukan pembuatan file baru, 

pemilihan satuan dan template, dan pembuatan garis bantu (grid). Jika langkah- 

langkah tersebut dilakukan, selanjutnya dilakukan pemodelan struktur. 

2.3.1. Membuat File Baru 

Pembuatan File baru dapat dilakukan dengan beberapa cara, yaitu: 

a. klik menu File> New Model…, 
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Gambar 2.5 Menu File 

b. klik perintah   pada toolbar, atau 

c. kombinasi Ctrl+N pada keyboard. 

2.3.2. Memilih Satuan dan Template 

Pemilihan satuan sangat penting dilakukan dalam proses input dan output, 

sehingga wajib diperhatikan sebelum melakukan pemodelan struktur cek terlebih 

dahulu satuan yang akan digunakan karena akan mempengaruhi hasil analisi 

struktur pada langkah selanjutnya. Kemudian pilih template yang akan digunakan 

dalam pemodelan struktur. Dalam praktikum statika ini biasanya dipakai template 

Blank atau Grid Only. 

 
 

Gambar 2.6 Kotak dialog New Model 

 

2.3.3. Membuat Grid (Garis Bantu) 

Pembuatan garis bantu ini dimaksudkan agar memudahkan dalam 

pemodelan. Perintah-perintah yang digunakan adalah sebagai berikut. 
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a. Klik kanan pada lembar kerja, pilih Edit Grid Data 

Gambar 2.7 Pilih Edit Grid Data 

b. Kemudian akan muncul tampilan seperti di bawah ini: 
 

 

Gambar 2.8 Kotak dialog Coordinate/Grid Systems 

c. Untuk membuat grid baru, klik Add New System, untuk menduplikat grid yang 

telah ada, klik Add Copy of System, untuk mengubah grid yang telah ada, klik 

Modify/Show System. Masukan data pada Defin Grid System Data, masukan data 

sesuai kebutuhan. 

 

 

Gambar 2.9 Kotak dialog Define Grid System Data 
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d. Masukan data seperti di bawah ini: 

1) pada bagian grid, isi bebas, bisa dengan abjad atau angka, 

2) ordinate berarti point-point yang diambil dari titik 0 dan sesuai sumbu. 

e. Kemudian klik OK sampai kembali kepada layar kerja windows, maka akan 

tampak garis bantu. 

 

Gambar 2.10 Tampilan lembar kerja setelah dibuat garis bantu (Grid) 

(lembar kerja dalam tampilan 3D) 

2.3.4. Menentukan Jenis Pembebanan 

Sebelum beban dimasukkan dalam pemodelan, terlebih dahulu ditentukan 

jenis pembebanannya. Perintah-perintah yang digunakan adalah sebagai berikut. 

a. Klik menu Define > Load Patterns…. 
 

Gambar 2.11 Menu Define 
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b. Setelah muncul kotak dialog Define Load Patterns. Buatlah Load Pattern baru 

dengan nama BEBAN pada Load Pattern Name dan tipe beban pilih 

OTHER(pilih pada tab Type). 

c. Isikan angka nol (0) pada Self Weight Multiplier karena dalam statika hanya 

menghitung reaksi perletakan dan gaya dalam akibat dari pembebanan (gaya 

luar) saja sehingga tidak perlu menambahkan berat baloknya sendiri. 

d. Kemudian klik Add New Load Pattern dan klik OK. 
 

Gambar 2.12 Kotak dialog Define Load Patterns 

2.3.5. Menggambar Frame 

Pemodelan struktur diawali dengan megggambar framedengan mengikuti 

garis bantu (grid) dengan cara sebagai berikut. 

a. Klik menu Draw > Draw Frame/Cable/Tendon (bisa juga melalui perintah di 

toolbar). 

 

Gambar 2.13 Menu Draw 
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b. Kemudian gambarkan frame sesuai dengan kebutuhan dengan mengikuti garis 

bantu yang sudah dibuat. Klik ujung garis bantu kemudian hubungkan dengan 

ujung lain sesuai pola. 

Gambar 2.14 Frame yang telah selesai dibuat (lembar kerja dalam tampilan 

X-Z Plane) 

2.3.6. Memberi Tumpuan 

Setelah menggambarkan frame, perlu adanya tumpuan yang berfungsi untuk 

memberikan reaksi terhadap pembebanan (gaya luar) agar tetap setimbang. 

Langkah-langkahnya yaitu: 

 

a. Klik joint yang akan diberikan tumpuan. 

 

Gambar 2.15 Tampilan Frame yang akan diberi tumpuan 
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b. Kemudian klik menu Assign > Joint > Restraints. 
 

Gambar 2.16 Menu Assign 

c. Kemudian pilih tumpuan pada bagian Fast Restraint di jendela Joint Restraint. 
 

Gambar 2.17 Kotak dialog Joint Restraints 

d. Kemudian klik OK, maka tumpuan telah di input di joint tersebut. 

 

2.3.7. Memberi Beban 

Langkah selanjutnya adalah pembebanan (pemberian gaya luar) yaitu 

dengan cara sebagai berikut. 
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a. Klik frame yang akan diberikan pembebanan 

 

Gambar 2.18 Tampilan Frame yang akan diberi beban 

b. Kemudian klik Assign >Frame Load , kemudian pilih jenis beban tersebut. 

(Apabila beban titik, maka pilih Point.., apabila beban merata, maka pilih 

Distributed.. 

 

Gambar 2.19 Menu Assign 

c. Apabila beban nya titik, maka pilih Point, maka akan muncul jendela Frame 

Point Loads. 

1) Pada Load Pattern Name, yaitu beban mati (DEAD) 

2) Cek satuan pada bagian Units 

3) Pilih jenis bebannya pada Load Pattern Name sesuai yang sudah dibuat. 
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4) Pilih beban yang akan bekerja, apakah berupa gaya atau momen pada 

Load Type and Direction. 

5) Bagian direction untuk menentukan arah dari gaya/beban tersebut. 

6) Pada bagian Options, add berarti memasukkan atau menambah gaya, 

Replace berarti mengganti gaya/beban, dan Delete berarti untuk menghapus 

gaya yang ada. 

7) Isikan letak dan besar pembebanan pada bagian Point Loads. 

8) Relative Distance from End-I berarti jarak yang digunakan yaitu jarak relatif 

dari titik awal ke titik akhir (bernilai 0-1) 

9) Absolute Distance from End-I berarti jarak yang digunakan yaitu jarak 

sebenarnya dari titik awal ke titik akhir. 

 

Gambar 2.20 Kotak dialog Frame Point Loads 

d. Setelah isian pada jendela Frame Point Load di isi, kemudian klik OK, maka 

beban akan muncul. 

 

Gambar 2.21 Tampilan Frame yang sudah diberi beban titik 
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e. Apabila beban merata, maka klik terlebih dahulu frame-nya, kemudian klik 

Assign >Frame Loads > Distributed.., maka akan muncul jendela Frame 

distribution Loads. 

f. Cara input beban untuk beban merata hampir sama dengan cara input beban titik 

yang telah dibahas. Untuk beban merata di input di Uniform load atau di 

Trapezoidal Loads. Uniform Load merupakan input beban merata untuk semua 

frame yang dipilih, dan trapezoidal loads untuk input beban merata di sebagian 

frame atau beban tidak merata (seperti beban segitiga). 

 

Gambar 2.22 Kotak dialog Frame Distributed Loads 

g. Setelah semua data beban telah di input-kan, klik OK. Maka beban akan muncul 

di pemodelan. 

h. Beban  merata   yang  telah  dibuatkan  akan      ditampilkan pada lembar kerja 

dan beban titik menjadi menghilang, padahal hanya disembunyikan. Agar beban 

titik muncul kembali dengan cara klik perintah pada toolbar, maka akan 

muncul jendela Show Frame Load. 

i. Kemudian klik OK, maka beban titik yang tadi tersembunyi akan muncul. 
 

Gambar 2.23 Tampilan Frame yang sudah diberikan pembebanan 
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j. Cara di atas apabila arah nya merupakan arah gravitasi atau arah vertikal ke 

bawah, apabila arahnya horizontal, maka caranya adalah sebagai berikut: 

1) Klik frame yang akan diberi pembebanan. 

2) Klik Assign >Frame Loads > Point (Karena yang akan di input merupakan 

beban titik, maka dipilih Point), maka akan muncul jendela Frame Point 

Load. 

3) Struktur Balok akan diberi beban tekan sejajar dengan sumbu X, maka pada 

bagian direction, ganti menjadi X. Apabila nilai beban positif, maka arahnya 

searah dengan sumbu X, apabila nilai beban negative, maka arahnya 

berlawanan arah dengan sumbu X. 

4) Isi jendela Frame Points Loads sesuai dengan gambar di bawah ini 
 

Gambar 2.24 Kotak dialog Frame Points Loads 

k. Klik OK. maka beban akan muncul dengan arah yang kita tentukan. 
 

Gambar 2.25 Tampilan Frame dengan beban titik horizontal 
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l. Pada stuktur gerber terdapat sambungan sendi, untuk memodelkan sambungan 

tersebut pilih Frame yang akan dijadikan sambungan. Kemudian pilih menu 

Assign > Frame > Releases/Partial Fixie… 

Gambar 2.26 Tampilan Frame dengan beban titik horizontal 

m. Setelah muncul kotak dialog Assign Frame Releases maka centang pada Momen 

33 (Major). Centang pada bagian start/end saja tergantung dimana balok 

tambahan tersebut akan diletakkan. 

 

Gambar 2.27 Tampilan Frame dengan beban titik horizontal 

n. Pada struktur rangka atau truss terdapat batang yang disambung disetiap titiknya, 

sehingga untuk memodelkan sambungan tersebut pilih semua Frame yang  akan  

dijadikan  sambungan.  Kemudian  pilih  menu  Assign  >  Frame 

>Releases/Partial Fixie…, setelah muncul kotak dialog Assign Frame Releases 
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maka centang pada Momen 33 (Major). Centang pada bagian start dan end 

karena batang tersebut disambung di setiap titik. 
 

Gambar 2.28 Tampilan Frame dengan beban titik horizontal 
 

 

Gambar 2.29 Tampilan Frame dengan beban titik horizontal 
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2.4. Langkah-langkah Analisis Struktur 

Setelah frame, tumpuan dan pembebanannya telah selesai di-input, maka 

dilakukan analisisterhadap struktur tersebut. Hasil analisis struktur yang akan 

ditampilkan pada praktikum ini adalah reaksi perletakan dan diagram gaya dalam. 

2.4.1. Run Analysis 

Analisis Struktur tersebut dilakukan dengan menggunakan perintah 

dibawah ini. 

a. Klik perintah di toolbar,      atau klik menu Analyze > Run Analysis atau 

klik F5 pada keyboard. 

b. Akan muncul jendela Set Load Case to Run 
 

Gambar 2.30 Kotak dialog Set Load Case to Run 

c. Matikan DEAD LOAD dengan cara, klik case DEAD, kemudian klik Run/Do 

Not Run Case, karena kita hanya menghitung pembebanan untuk jenis beban 

yang telah kita buat sebelumnya. 

d. Case MODAL berfungsi untuk analisis dinamis, namun tidak terlalu berpengaruh 

pada pemodelan sederhana seperti pemodelan statika ini, sehingga boleh 

dibiarkan berjalan (run) atau boleh juga dimatikan 

e. Kemudian Klik Run Now, tunggu sampai proses selesai. Apabila proses analysis 

telah berhasil, maka akan muncul deformasi dari pemodelan struktur tersebut. 

f. Setelah proses analisis, kita juga akan memperoleh reaksi perlatakan dan gaya 

dalam, dari perancangan sturktur tersebut. 
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Gambar 2.31 Tampilan Deformed Shape 

 

2.4.2. Melihat Reaksi Perletakan 

Reaksi perletakan dapat diketahui menggunakan perintah dibawah ini. 

a. Klik Display > Show Forces/Stersses > Joints. 
 

 

Gambar 2.32 MenuDisplay 

b. Akan muncul jendela Joint Reaction Forces, centang pada Show Result as 

Arrows agar terlihat arah reaksi. 

c. Klik OK. 
 

 

Gambar 2.33 Tampilan Reaksi perletakan (Joint Reactions) 
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2.4.3. Melihat Diagram Gaya Dalam 

Diagram Gaya dalamdapat diketahui menggunakan perintah dibawah ini. 

a. Klik Menu Display > Show Forces/Stersses >Frames/Cables… 
 

Gambar 2.34 Menu Display 

b. Akan muncul jendela Member Force Diagram for Frames 
 

Gambar 2.35 Kotak dialog Member Force Diagram for Frames 

c. Pada bagian component, pilih Axial Force untuk NFD, Shear 2-2 untuk SFD 

dan Moment 3-3 untuk BMD. 
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d. Setelah di klik OK, maka akan ada tampilan sebagai berikut: 

1) Axial Force (NFD) 
 

Gambar 2.36 Tampilan Axial Force Diagram 

2) Shear 2-2 (SFD) 
 

Gambar 2.37 Tampilan Shear 2-2 Diagram 

3) Moment 3-3 (BMD) 
 

Gambar 2.38 Tampilan Moment 3-3 Diagram 



 

 

BAB III. SIMPLE BEAM  
 

3.1. Pendahuluan 

Simple Beam (Balok sederhana) adalah balok yang ditumpu oleh tumpuan 

sendi pada salah satu ujungnya, dan tumpuan rol pada ujung lainnya. Contoh 

aplikasi struktur balok sederhana adalah jembatan sederhana yang menggunakan 

tumpuan sendi pada salah satu ujungnya dan tumpuan rol pada ujung lainnya. 

3.2. Tujuan 

Pengujian ini bertujuan untuk menentukan nilai reaksi perletakan yang 

dihasilkan dari beban yang diberikan pada struktur simple beam. 

3.3. Alat 

a. Pemberat 

b. Timbangan 

c. Alat Pengukur (meteran) 

3.4. Cara Pengujian 

a. Atur dan susun rangka batang dan tumpuan sesuai dengan struktur simple 

beam. 

b. Pasang dan atur pengait beban dengan jarak yang sudah ditentukan sesuai 

dengan pembebanan struktur. 

c. Lakukan kalibrasi timbangan setelah semua tersusun sesuai dengan struktur 

simple beam. 

d. Letakkan pemberat dengan berat yang sudah ditentukan pada pengait beban. 

e. Baca dan catat reaksi perletakan yang dihasilkan pada timbangan. 

3.5. Perhitungan 

Diketahui sebuah balok sederhana seperti gambar dibawah ini, hitung reaksi 

perletakan dan gaya dalam yang bekerja pada balok. 
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Gambar 3.1 Contoh soal balok sederhana 

Jika diuraikan gaya-gayanya, maka akan menjadi gambar dibawah ini. 
 

Gambar 3.2 Uraian gaya-gaya dalam perhitungan 
 
 

Px = P cos300 

= 10 cos300 

= 8,667 kN 

3.5.1. Reaksi Perletakan 

∑MC = 0 

RAV.(6+4)– Py.(4) = 0 

RAV.(10)– 5.(4) = 0 

RAV.(10)– 20 = 0 

RAV = 2 Kn 

Py = P sin300 

= 10 sin300 

= 5 kN 

 
 

∑MA = 0 

Py.(6)– RCV.(6+4)= 0 

5.(6)– RCV.(10) = 0 

30– RCV.(10) = 0 

RCV = 3 kN 

 
Kontrol 

∑V= 0 

RAV +RAV – Py = 0 

2 + 3 – 5 = 0...(OK) 

 

∑H= 0 

RAH +Px = 0 

RAH = – Px 

RAH = – 8,667 kN 
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3.5.2. Gaya-gaya dalam 

a. NFD 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan 

NA = –RAH 

 = –(–8,667) 

 = 8,667 kN 

NB = –RAH 

 = –(–8,667) 

 = 8,667 kN 

NC =0 kN 

(Balok tersebut mengalami tarik dari titik A sampai B) 
 

b. SFD 

VA = RAV 

= 2 kN 

VB = VA – Py 

= 2 – 5 

= -3 kN 

 

VC = VB + RCV 

= –3 + 3 

= 0 kN 

 

c. BMD 

MA = 0 kNm 

MB = RAV.(6) 

= 2.(6) 

= 12 kNm 

MC = [RAV.(6+4)] – (Py.4) 

= 2.(10) – (5.4) 

= 0 kNm 
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3.5.3. Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 

Gambar 3.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 



 

 

BAB IV. SIMPLE BEAM OVERHANG 
 

4.1. Pendahuluan 

Balok menggantung (beam overhanging) merupakan balok sederhana yang 

salah satu sisinya memanjang/berlebih melewati kolom tumpuannya. Sehingga 

balok tersebut seperti menggantung di salah satu sisinya. Konsep perhitungan dari 

simple beam overhang ini hampir sama dengan dengan konsep pada balok 

sederhana. 

Penerapan simple beam overhang di lapangan biasanya adalah untuk 

penopang atau dudukan panel lantai. 

4.2. Perhitungan 

Diketahui sebuah beam cantilever seperti gambar dibawah ini, tentukan 

reaksi perletakan, dan gaya normal yang bekerja pada struktur dibawah ini. 

 

Gambar 4.1 Contoh soal simple beam overhang 

 
 

Jika diuraikan gaya-gayanya, maka akan menjadi gambar dibawah ini. 

 

Gambar 4.2 Uraian gaya-gaya dalam perhitungan 
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4.2.1. Reaksi Perletakan   

∑MB = 0  ∑MA= 0 

RAV.(8)– R.(0,5.8)– P1.(4)+P2.(2) = 0 

RAV.(8)– 800.(4)– 50.(4) +40.(2) = 0 

RAV.(8)– 3200– 200 + 80 = 0 

RAV.(8)= 3320 

RAV = 415 kN 

 –

RBV.(8)+R.(0,5.8)+P1.(4)+P2.(10)=0 

–RBV.(8)+800.(4)+ 50.(4)+40.(10)=0 

–RBV.(8)+ 3200+ 200 + 400 = 0 

–RBV.(8)= –3800 

RBV = 475 kN 

 

Kontrol 

  

∑MB = 0 

RAV + RBV – R– P1 – P2 = 0 

415+ 475 – 800– 50– 40 = 0...(OK) 

 

 ∑H= 0 

 

RAH = 0 

 
4.2.2. Gaya-gaya dalam 

  

a. NFD 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan

N = - RAH 

    = 0 kN 

(Tidak ada gaya aksial yang bekerja pada balok) 

b. SFD 

VA = RAV 

      = 415 kN 

Vc = VA  - q.(4) 

     = 415 – 100.(4) 

     = 15 kN 
 

 

c. BMD 

VC’ = VC – P1   VB’ = VB+ RBV 

      = 15 – 50         = –435 + 475 

      = –35 kN         = 40 kN 

VB = VC’– q.(4)  VD = VB’ – P2 

     = –35 – 100.(4)        = 40 – 40 

     = –435 kN         = 0 kN   
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4.2.3. Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 
 

 

Gambar 4.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 



 

 

BAB V. KANTILEVER 
 

5.1. Pendahuluan 

Kantilever merupakan balok yang terjepit pada salah satu ujungnya  (terdapat 

tumpuan jepit) sedangkan ujung lainnya bebas tanpa ditumpu oleh tumpuan lain. 

Tumpuan jepit mampu menahan gaya dari berbagai arah dan menahan momen, 

sehingga terdapat 3 variabel reaksi yang harus di cari dalam struktur balok 

kantilever, yaitu RAH, RAV, dan MA (apabila tumpuan jepit di titik A). Penerapan 

balok kantilever biasanya digunakan untuk balkon, dinding penahan tanah, dan lain-

lain. 

5.2. Perhitungan 

Diketahui sebuah kantilever seperti gambar dibawah ini, tentukan reaksi 

perletakan dan gaya- gaya dalam yang bekerja pada struktur tersebut. 

 

Gambar 5.1 Contoh soal kantilever 

 
 

Jika diuraikan gaya-gayanya, maka akan menjadi gambar dibawah ini. 
 

Gambar 5.2 Uraian gaya-gaya dalam perhitungan 

Px = P cos30o 

= 8 cos30o 

                                = 6,93 kN 

                   Py      = P sin30o 

                             = 8 sin30o 

                        = 4 kN 

R  = q . L 

     = 2 . 4 

     = 8 kN
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45 
 

 

 

5.2.1. Reaksi Perletakan   

∑V= 0 

RAV – R – Py = 0 

 ∑MA= 0 

MA+ R.(0,5.4)+ Px.(4) = 0 

RAV = R + Py 

RAV = 8 + 4 = 12 kN 

 MA + 8.(2)+ 4.(4) = 0 

MA =–16 – 16 = –32 kN 

 

Kontrol 

  

 

∑MB = 0 

MA + RAV.(4)+ R.(0,5.4) = 0 

 ∑H= 0 

RAH – Px = 0 

–32 + 12.(4) – 8.(2) = 0...(OK)  RAH    = Px  

RAH           = 6,93 kN 
 
5.2.2. Gaya-gaya dalam 

  

a. NFD 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan 

NA = – RAH 

= – 6,93 kN 

NB = – RAH 

= – 6,93 kN 

(Balok tersebut mengalami tekan di seluruh bentang) 

b. SFD 

VA = RAV 

= 12 kN 

 
 

 

VB = VA – R 

= 12 – 8 

= 4 kN 
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5.2.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 

 

Gambar 5.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 



 

 

BAB VI. GERBER 

6.1.  Pendahuluan 

Balok gerber merupakan konstruksi balok di atas beberapa tumpuan, yang 

merupakan gabungan konstruksi balok menggantung (beam cantilever) yang 

disambungkan dengan balok lain. Balok menggantung yang terlalu panjang akan 

menyebabkan terjadinya momen lentur yang terlalu besar, sehingga perlu diambah 

dengan konstruksi balok lain. Hal ini menyebabkan kontruksi tersebut menjadi 

struktur statis tak tentu (lihat persamaan 1.4). Agar sifat konstruksi itu kembali 

menjadi statis tertentu maka digunakan sambungan sendi. 

 

6.2.  Perhitungan 

Diketahui sebuah balok gerber seperti gambar dibawah ini, tentukan reaksi 

perletakan dan gaya-gaya dalam yang bekerja dalam balok tersebut. 

 

Gambar 6.1 Contoh soal balok gerber 
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6.2.1. Reaksi Perletakan 

a. Tinjau batang S-E untuk mengetahui nilai REV dan VS. 
 

 

 
∑MS = 0 

REV.(2 + 3)– P.(2)= 0 

REV.(5)– 20.(2)= 0 

REV.(5)– 40= 0 

REV.(5)= 40 

REV = 8 kN 

Kontrol batang S-E 

∑V= 0 

REV + RS – P = 0 

8 + 12 – 0 = 0...(OK) 

Gambar 6. 2 Tinjauan batang S-E 

∑ME = 0 

RS.(2 + 3)– P.(3)= 0 

RS.(5)– 20.(3)= 0 

RS.(5)– 60= 0 

RS.(5)= 60 

RS = 12 kN 
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b. Tinjau batang A-C-S untuk mengetahui nilai RAV dan RCV. 

 

 

 
∑MC = 0 

Gambar 6.3 Tinjauan batang A-C-S 

∑MA= 0 

RAV.(3 + 3)– P.(3)+ RS.(2) = 0 

RAV.(6)– 20.(3)+ 12.(2) = 0 

RAV.(6)– 60 + 24= 0 

RAV.(6)= 36 

RAV = 6 kN 

Kontrol batang A-C-E 

∑V= 0 

RAV + RCV+ REV+ P – P = 0 

6 + 26 + 8 – 20 – 20 = 0...(OK) 

6.2.2. Gaya-gaya dalam 

a. NFD 

P.(3)– RCV.(3 + 3)+ RS.(3+3+2)= 0 

20.(3)– RCV.(6)+ 12.(8)= 0 

60– RCV.(6)+ 96= 0 

– RCV.(6)= –156 

RCV = 26 kN 

∑H= 0 

RAH = 0 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan 

N = –RAH 

= 0 

(Tidak ada gaya aksial yang bekerja pada balok) 

b. SFD 

VA = RAV 

= 6 kN 

VB = VA – P 

= 6 – 20 

= –14 kN 

VC   = VB + RCV 

= –14 + 26 

= 12 kN 
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VD = VC – P 

= 12 – 20 

= – 8 kN 

 

VE = VD + REV 

= –8 + 8 

= 0 kN 

 

 

c. BMD 

MA = 0 kNm 

MB = RAV.(3) 

= 6.(3) 

= 18 kNm 

MC = RAV.(3+3) – P.(3) 

= 6.(6) – 20.(3) 

= – 24 kNm 

 
 

MD =RAV.(3+3+2+2) – P.(3+2+2) 

+ RCV.(2+2) 

= 6.(10) – 20.(7) + 26.(4) 

= 24 kNm 

ME = RAV.(3+3+2+2+3) – 

P.(3+2+2+3) + RCV.(2+2+3) 

– P. (3) 

= 6.(13) – 20.(10) + 26.(7) – 

20.(3) 

= 0 kNm 
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6.5.3. Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 
 

Gambar 6.4 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 
 



 

 

BAB VII. PORTAL 2D 

7.1. Pendahuluan 

Portal adalah suatu sistem yang terdiri dari bagian-bagian struktur yang saling 

berhubungan yang berfungsi menahan beban sebagai suatu kesatuan lengkap yang 

berdiri sendiri dengan atau tanpa dibantu oleh diafragma-diafragma horisontal atau 

sistem-sistem lantai. Bangunan portal banyak dijumpai sebagai konstruksi 

bangunan gudang, hangar dan jembatan. 

7.2. Perhitungan 

Diketahui sebuah portal seperti gambar 7.1 di bawah ini, tentukan reaksi 

perletakan dan gaya- gaya dalam yang bekerja pada struktur tersebut. 

 
 

Gambar 7.1 Contoh soal portal 

 
Jika diuraikan gaya-gayanya, maka akan menjadi gambar di bawah ini. 

 

 

 
 

Gambar 7.2 Uraian gaya-gaya dalam perhitungan 
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7.2.1. Reaksi Perletakan   

 ΣMB = 0 

 8Ra – P . 6 = 0 

 ΣMA = 0 

8Rb – P . 2 = 0 

 8Ra – 2 . 6 = 0 

 Ra = 
12

8
  = 1,5 T 

 

 8Rb – 2 . 2 = 0 

Rb = 
4

8
  = 0,5 T 

 
 

Kontrol 

 

Σ MV = 0 

Ra + Rb – P = 0 

1,5 + 0,5 - 2 = 0...(OK) 

 

 
7.2.2. Gaya-gaya dalam 

  

a. NFD 

Anggapan arah NFD berlawanan arah dengan reaksi perletakan 

NAC = – RAV 

= – 1,5 T 

NBD = – RBV 

= – 0,5 T 

(Balok tersebut mengalami tekan di seluruh bentang) 

b. SFD 

      DA = 0 Ton 

      DC = RAV  

            = 1,5 T 

     

 
 

 

 

c. BMD 

MA = 0 Tm 

MC = 0 Tm 

 

DE = RAV – P  

      = 1,5 - 2  

     = 0,5 T 

DD = RAV – P + RBV  

      = 1,5 – 2 + 0,5  

      = 0 T 

 
 

ME = RAV . 2  

      = 1,5 . 2 = 3 Tm 

MD = RAV . 8 – P . 6  

       = 1,5 . 8 – 2 . 6 = 0 Tm 

MB = 0 Tm
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7.2.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam 

 

 
 

Gambar 7.3 Penggambaran Reaksi Perletakan dan Diagram Gaya Dalam



 

 

BAB VIII. RANGKA BATANG (TRUSS) 

8.1. Pendahuluan 

Dalam melakukan analisis suatu struktur rangka batang terlebih dahulu harus 

ditetapkan suatu aturan perjanjian tanda. Dalam struktur rangka batang, setiap 

batang diasumsikan hanya memikul gaya aksial, sehingga hanya dimungkinkan 

timbul gaya aksial tekan atau gaya aksial tarik. Arah gaya pada masing-masing 

batang digambarkan sebagai tanda panah yang berpusat pada suatu titik kumpul. 

Gaya aksial tarik digambarkan sebagai satu anak panah yang berarah keluar dari 

titik kumpul (meninggalkan joint) dan diberi tanda positif (+), sedangkan gaya 

aksial tekan digambarkan sebagai suatu anak panah yang berarah masuk ke dalam 

titik kumpul (menuju joint) dan diberi tanda negatif (-). 

Selanjutnya untuk menentukan besaran gaya batang harus dilakukan analisis 

struktur, ada beberapa metode analisis struktur yang sering digunakan. Tiap metode 

dapat digunakan tergantung keperluan atau tujuan analisisnya. Dalam modul ini 

akan dibahas mengenai Metode Titik Kumpul (Method of Joints) dan Metode 

Cremona. Kemudian dari kedua metode tersebut nantinya akan dibandingkan 

dengan hasil dari pemodelan menggunakan program SAP2000. 

8.2. Metode Titik Kumpul (Method of Joints) 

 Metode ini merupakan metode dasar yang dapat digunakan untuk 

menganalisis suatu struktur rangka batang. Apabila diperlukan untuk mengetahui 

seluruh nilai gaya batang, maka dapat digunakan metode joint ini. Metode ini 

dilakukan dengan cara meninjau syarat kesetimbangan gaya di setiap titik kumpul, 

menggunakan persamaan H = 0 dan V = 0. Pada titik kumpul (joint) yang 

ditinjau, dapat digambarkan semua gaya batang yang ada beserta gaya-gaya luar 

yang bekerja pada joint tersebut, termasuk reaksi tumpuan bila ada. Sebagai asumsi 

awal, semua gaya batang yang digambarkan pada tiap joint dapat  digambar sebagai 

suatu gaya tarik (meninggalkan joint). Jika pada saat analisis diperoleh hasil negatif, 

berarti arah gaya tersebut berlawanan dengan arah gaya asumsi awal. 
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Langkah pertama untuk melakukan metode ini adalah dengan menghitung 

reaksi perletakan terlebih dahulu. Selanjutnya perhitungan gaya batang dengan 

metode ini dapat dimulai pada joint yang hanya memiliki maksimum dua buah 

batang yang tidak diketahui dan diasumsikan meninggalkan joint (diasumsikan 

tarik). Biasanya dapat dimulai pada titik tumpuan. Analisis dapat dilanjutkan pada 

tiap joint, hingga seluruh gaya batang dapat dihitung besarnya. 

8.2.1. Perhitungan 

Diketahui sebuah stuktur rangka atap seperti gambar dibawah ini, hitunglah 

reaksi perletakan dan gaya dalam yang bekerja pada struktur tersebut. 

Gambar 8.1 Contoh soal rangka batang 

Jika diuraikan gaya-gayanya, maka akan menjadi gambar dibawah ini. 
 

Gambar 8.2 Reaksi perletakan 
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∑MB = 0 

RAV.(6)– P.(3) = 0 

RAV.(6) – 20.(3) = 0 

RAV.(6) = 60 

RAV = 10 Ton 

Kontrol 

∑V= 0 

RAV + RBV– P = 0 

10 + 10 – 20 = 0...(OK) 

∑MA = 0 

–RBV.(6)+ P.(3) = 0 

–RBV.(6) + 20.(3) = 0 

–RBV.(6) = –60 

RBV = 10 Ton 

 
∑H= 0 

RAH = 0 

 

 

8.2.2. Tinjauan gaya batang pada tiap joint 

a. Joint A 
 

 

 
∑V = 0 

     

Gambar 8. 3 Tinjauan di titik A 

∑H = 0 

FAD + FAC.c α = 0 

FAD = –FAC.cos(45) 

FAD= –14,14.cos(45) 

  
       

FAD = 10 Ton (Tarik) 

Jika diperoleh nilai negatif, berarti arah gaya berlawanan dengan arah asumsi 

awal. 
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b. Joint C 

 

 

 
∑H = 0 

Gambar 8.4 Tinjauan di titik C 

∑V = 0 

–FAC.c α FBC.c α = 0 

FBC.c  α  =  FAC.c   α 

FBC = FAC 

FBC = –14,14 Ton (Tekan) 

 

c. Joint D 

–FAC.  α–FBC.   α–P – FCD = 0 

FCD = –(–14,14.sin(45))–(–14,14. 

sin(45)) – 20 

FCD = –(–10) – (–10) – 20 

FCD = 0 Ton 

 

 

 
 

 
∑H = 0 

–FAD + FBD = 0 

FBD = FAD 

 

Gambar 8.5 Tinjauan di titik D

FBD = 10 Ton (Tarik) 
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8.2.3. Kesimpulan metode joint 

Tabel 8.1 Gaya batang menggunakan metode joint 
 

Batang Gaya (Ton) Keterangan 

AC –14,14 Tekan 

AD 10 Tarik 

CD 0 - 

BD 10 Tarik 

BC –14,14 Tekan 
 

 
Gambar 8.6 Gaya Aksial yang dialami batang 

 

8.2.4. Perbandingan Gaya Batang dari Metode Joint dengan Program SAP2000 

Tabel 8.2 Perbandingan Gaya Batang  
 

Batang Metode Joint 
Program SAP2000 

Gaya (Ton) Error*) 

AC –14,14 –14,14 0 % 

AD 10 10 0 % 

CD 0 0 0 % 

BD 10 10 0 % 

BC –14,14 –14,14 0 % 

*)persentase ketidak tepatan terhadap nilai gaya dari metode joint 
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8.3. Metode Cremona 

Metode Cremona adalah metode penyelesaian gaya-gaya batang dengan  

cara grafis. Pemahaman konsep tentang perhitungan dengan metode ini perlu 

dikuasai. Prinsip dalam perhitungan Metode Cremona yaitu sebagai berikut 

Langkah-langkah: 

1. hitung terlebih dahulu reaksi-reaksi tumpuan 

2. skala perlu diperhatikan sebelum memulai penggambaran. 

3. pada setiap titik buhul maksimum hanya ada 2 gaya yang belum diketahui, 

biasanya penggambaran gaya batang dimulai dari titik tumpuan 

(perletakan). 

4. penggambaran gaya batang diurutkan searah jarum jam. 

5. besarnya gaya batang berprinsip bahwa resultan seluruh gaya luar dan gaya 

dalam sama dengan 0. 

6. penggambaran arah gaya batang harus sejajar batang yang dihitung 

gayanya. 

7. gaya yang arahnya meninggalkan titik buhul adalah batang tarik, 

sedangkan 

gaya yang arahnya menuju titik buhul adalah batang tekan, 

8. penggambaran gaya harus membentuk sebuah polygon tertutup yang 

membentuk sebuah siklus, dan 

9. besarnya gaya tiap batang dibuatkan dalam tabel dan kemudian perhitungan 

tersebut disimpulkan. 
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8.3.1. Perhitungan 

Langkah pertama sama seperti metode joint yaitu terlebih dahulu dicari 

reaksi perletakannya, sehingga didapat nilai RAV dan RBV sebesar 10 Ton seperti 

gambar di bawah ini.     

 
Gambar 8.7 Nilai reaksi perletakan  

Selanjutnya membuat daftar kontruksi gaya batang yang ada pada titik 

buhul untuk mengetahui gaya batang yang sudah diketahui dan yang akan dicari 

nilai gayanya.  

Buatlah tabel seperti Tabel 8.2 di bawah ini, tanda kurung pada kolom gaya 

adalah gaya yang sudah diketahui nilainya sedangkan yang tidak dikurung adalah 

gaya yang akan dicari nilainya. Sepakati juga tentang arah penggambaran gayanya, 

pada praktikum ini penggambaran gayanya searah jarum jam. 

Tabel 8.3 Daftar kontruksi gaya batang 
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Titik A 

 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 8.8 Gaya batang pada titik A 

Titk D 

 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 8.9 Gaya batang pada titik D 

Titik C 

 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 8.10 Gaya batang pada titik C 
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Titik B 

 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 8.11 Gaya batang pada titik B 

Gabungan dari semua gaya 

 

Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg 

Gambar 8.12 Gabungan gaya batang 

8.3.3 Kesimpulan Metode Cremona 

Tabel 8.4  Gaya batang menggunakan metode cremona 
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(Skala jarak 1 : 100 cm, skala gaya 1 : 5000 kg) 

Gambar 8.13 Gaya Aksial yang dialami batang 

8.3.3 Perbandingan Gaya Batang dari Tiga Metode 

Tabel 8.5  Perbandingan Gaya Batang dari Tiga Metode 
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8.4. Metode Potongan (Method of Ritter) 

Pada metoda ini, penentuan besarnya gaya-gaya batang dilakukan dengan 

menganalisis potongan yang dibuat oleh garis fiktif yang memotong maksimum 3 

batang yang belum diketahui gaya batangnya. 

Langkah-langkah: 

1. hitunglah reaksi peletakan dengan menganggap rangka batang sebagai balok 

sederhana di atas dua peletakan. 

2. buatlah garis potongan fiktif dengan pertimbangan garis tersebut hanya 

memotong batang maksimum 3 batang yang belum diketahui gaya batangnya. 

3. peninjauan potongan hanya pada salah satu bagian atau sisi saja (freebody kiri 

atau freebody kanan), karena peninjauan freebody kiri maupun freebody kanan 

akan men ghasilkan besar gaya dan arah gaya yang sama. 

4. seluruh gaya batang yang dicari, gaya-gaya luar (beban) dan reaksi peletakan 

harus diperhitungkan, demikian pula jarak joint dari batang yang terpotong 

harus tergambarkan. 

5. gaya batang yang belum diketahui selalu diumpamakan sebagai gaya tarik / 

positif (+) terlebih dahulu. Bila hasil perhitungannya memberikan hasil negatif 

(-), maka arah gaya batang dapat dibalik tetapi nilainya berubah menjadi positif. 

6. menentukan besarnya gaya batang dengan menghitung jumlah momen pada 

suatu titik tertentu (akibat reaksi, beban luar dan gaya batang pada irisan yang 

ditinjau) harus sama dengan nol → ∑M = 0 

7. buatlah potongan-potongan yang lainnya sehingga semua gaya batang dapat 

ditentukan. 

Beberapa catatan penting tentang cara Ritter : 

1. Metode Ritter dapat dikombinasikan dengan metode Keseimbangan Titik, 

dalam arti setelah mencari beberapa gaya batang dengan menggunakan cara 

Ritter dapat dilanjutkan mencari gaya batang lainnya dengan menggunakan 

cara keseimbangan titik, atau sebaliknya. 

2. Gaya-gaya batang yang terpotong bersama-sama dengan reaksi-reaksi 

peletakan dan beban-beban yang bekerja harus membentuk keseimbangan. 
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3. Gaya-gaya batang yang terpotong mewakili beban-beban luar dan reaksi- reaksi 

tumpuan dari bagian potongan yang tidak ditinjau. 

4. Setiap freebody yang ditinjau dapat dikontrol keseimbangannya, sehingga gaya 

batang yang diperoleh dapat lebih diyakini kebenarannya dibandingkan dengan 

metode Keseimbangan Titik. 

5. Garis fiktif dapat memotong jumlah batang lebih dari tiga buah asalkan gaya 

batang yang belum diketahui paling banyak tiga buah. 

6. Perhitungan gaya-gaya batang yang lainnya harus dilakukan potongan melalui 

gaya-gaya batang yang dicari. 

Contoh: 

Berikut ini contoh dari rangka batang (contoh pertama) yang telah dihitung 

reaksi peletakannya. Perhatikan rangka batang tersebut ! Garis fiktif x-y memotong 

maksimum 3 batang yang tidak diketahui gaya batangnya, yaitu S1, S3, dan S7. 

Kemudian dilakukan pemisahan potongan pada garis fiktif tersebut, yaitu freebody 

kiri dan freebody kanan. 

 

8.4.1. Perhitungan 

 

Gambar 8.14 Contoh Soal Rangka Batang 
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Karena konstruksi dan bebannya simetri maka besar RA dan RB sama yaitu 

sama dengan setengah dari jumlah bebannya 

 

Gambar 8.15 Penyelesaian Potongan A-A 

 

Gambar 8.16 Penyelesaian Potongan B-B 
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Gambar 8.17 Penyelesaian Potongan 

 

Gambar 8.18 Penyelesaian Potongan C-C
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Gambar 8.19 Penyelesaian Potongan D-D 

 

Tabel 8.6  Gaya batang menggunakan metode ritter 
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LAMPIRAN 1 
 

 

KETENTUAN PRAKTIKUM 

 
 

1. Praktikum Statika bersifat individual 

2. Peserta WAJIB mengikuti tutorial sesuai dengan jadwal yang telah ditentukan 

dan datang TEPAT WAKTU, apabila peserta datang lebih dari 15 menit, maka 

tidak diperbolehkan untuk mengikuti tutorial. 

3. Peserta WAJIB mengenakan pakaian sopan, kemeja, celana atau rok panjang, 

serta bersepatu. Peserta yang berpakaian tidak sesuai peraturan tidak boleh 

mengikuti tutorial. 

4. Peserta WAJIB membawa modul setiap tutorial. 

5. Segala bentuk pekerjaan praktikum menjadi tanggung jawab masing-masing, 

jika terjadi pelanggaran (keterlambatan, mengganti soal, dan 

memanipulasi/memalsukan tanda tangan asisten) akan dikenakan sanksi 

berupa pengurangan nilai. 

a. Lewat batas deadline, kurangi 5 poin per hari 

b. Mengganti soal, kurangi 10 poin (dari keseluruhan) 

c. Memanipulasi tanda tangan, kurangi 20 poin (dari keseluruhan) 

6. Kriteria penilaian berupa 

a. Laporan (bobot 60 %) 

b. Presensi/kehadiran (bobot 10 %) 

c. Softskill (bobot 10 %) 

d. Keaktifan (bobot 20 %) 

7. Asistensi hanya akan dilayani jika pekerjaan sesuai dengan format laporan 

praktikum dan hanya dilakukan dilingkungan kampus terpadu Universitas 

Muhammadiyah Yogyakarta. 

8. Setiap praktikan diwajibkan melakukan asistensi kepada asisten praktikum 

setiap mendapatkan tugas. 

9. Selalu sertakan nama dan selalu menjaga etika jika menghubungi (SMS) 

asisten. 

10. Pada lembar pengesahan WAJIB terdapat tanda tangan asisten sebelum 

responsi dosen. Apabila tidak terdapat tanda tangan asisten, mahasiswa 

TIDAK BERHAK mengikuti RESPONSI DOSEN. 
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